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Introduction 
 
 

 You will gain the most from this guide by first reviewing it. Also, be sure 
to backup your data. 

 
Data integration between BillQuick® (by BQE Software, Inc.) and Peachtree Accounting® (by Sage 
Software SB, Inc.) can make your time billing, accounting and financial management tasks easier. Full-
featured, BillQuick Time and Billing helps you manage your company, whether your time, expense, 
billing, project management and reporting needs are simple or you demand complex billing, reporting and 
management capabilities. Peachtree Accounting is a business accounting software  that provides solutions 
such as general accounting, limited time and billing, accounts receivable, accounts payable, inventory, 
online banking, job costing, reporting and payroll services. Integrated, BillQuick and Peachtree deliver a 
virtual application that ensures data accuracy, eliminates time-consuming duplicate manual entry, enhances 
flexibility, and increases control over your bottom line.  
 
The goal of the BillQuickªPeachtree Integration Guide is to help users effectively integrate data 
between BillQuick and Peachtree Accounting. BillQuick controls integration, enabling you to choose 
General Ledger accounts, what data flows between the applications, and more. 
 
 

How to Use This Guide 
 
Integration means data from one application transfers to another. This sharing offers many benefits. You 
control what data transfers to and from BillQuick using synchronization settings. Your preferences tell 
BillQuick exactly how you want it to interact with Peachtree. BillQuick automatically creates smart 
connection using your settings and built-in intelligence. 
 
We encourage you to review How Integration Works. Written for the non-technical user, it explains 
the integration rules built into BillQuick. Understanding what type of data may be shared and the rules 
applied during synchronization, will help you visualize what is happening behind the scenes. 
 
In the Initial Integration Scenarios section, you can choose the scenario which best fits your company. 
Instructions guide you through initial integration process according to your situation, whether new or 
existing BillQuick/Peachtree user.  
 
After integration, data is to be checked to make sure everything is synchronized accurately. Quick 
Check section provides specific guidance on this aspect. The section on Day-to-Day Integration 
Settings provides suggestions for fine-tuning synchronization settings for normal, day-to-day processing.  
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Software Editions Supported 
 
BillQuick Basic, Pro (Microsoft Access database) and Enterprise (MSDE, SQL Express and Microsoft SQL 
database) editions (2005 or later) integrates with the following Peachtree editions (versions 2005 and 
later): 
 
¶ Peachtree Complete Accounting® 
¶ Peachtree Accounting® 
¶ Peachtree Premium Accounting®  
¶ Peachtree Premium Accounting for Construction/ Distribution/Manufacturing/Non-Profit (2006 

or later) 
¶ Peachtree Premium Accounting Accountantõs Edition (2006 or later) 
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How Integration Works 
 
 
Even if you are not a technical person, it is helpful to understand the basics of BillQuickªPeachtree 
Accounting integration. This can help you visualize what is happening behind the scenes as BillQuick 
manages transfer of information to and from Peachtree. 
 
You can send BillQuick activities, expense codes, employees, vendors, clients, projects, time entries, 
invoices and payments to Peachtree. You can get activity and expense/charge items, employees, vendors, 
customers, jobs, expense and time entries, invoices and payments from Peachtree into BillQuick. You 
have to send or get the data in the order of the menu. E.g., send Clients prior to sending the Projects. 
Each record common to BillQuick and Peachtree share a unique Link ID that identifies them as related. 
This does not mean data in both records is exactly the same, only that they share common data. BillQuick 
Project records contain data and options that Peachtree Job records do not and vice versa. What is 
important for integration is that the two applications share key data.  

 

 Before integrating data, backup your data in Peachtree Accounting and 
BillQuick. 

 
The table below shows the directions in which data can potentially flow between BillQuick and 
Peachtree. Whether it flows in one direction or the other depends on your choices on the 
BillQuickªPeachtree Sync Settings screen.  
 

BillQuick  
Table Name 

Dataflow Peachtree  
Table Name 

Activity Code D Inventory Item  
(Activity) 

Expense Code D Inventory Item  
(Charge) 

Employee D Employee 

Vendor D Vendor 

Client D Customer 

Project D Job 

Time Entry D Time Ticket 
Expense Log ! Expense Ticket 

Invoice D Invoice  
(Sales & Invoicing) 

Payments D Payments  
(Receipts) 

Chart of Accounts D Chart of Accounts 

 
To review detailed, field-by-field mapping of records between Peachtree 
Accounting and BillQuick, see BillQuick Help, BillQuick-Peachtree 

Integration, Table & Field Mapping. 
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As you can see above, BillQuickõs integration with Peachtree is very comprehensive. Not only are 
invoices sent to Peachtree to post revenue and receivables, the virtual database for the two applications 
includes clients, projects/jobs, employees, vendors, activity codes, etc.  
 
Bottom Line: The major benefit is that you do not have to reenter BillQuick data into Peachtree. BillQuick 
manages the process, using your synchronization settings. 
 
 

Integration Rules 
 
To ensure accuracy and completeness of data transfer, BillQuickªPeachtree integration follows a set of 
rules. These are: 
 

1. Start Date Rule: Peachtree accepts the transfer of time, expense, invoice and payment 
records only if their dates are after the start date of the Peachtree Company. Thus, when 
you are an existing BillQuick user integrating with Peachtree for the first time, or you are 
new to both BillQuick and Peachtree and manually entering invoices, payments, and/or 
time and expenses from a prior fiscal year, be sure to check the start date of the 
Peachtree Company.  

2. Synchronization Order Rule: When you send or get data on-demand from BillQuick 
or Peachtree (via Send, Get or Sync menu), follow the order of the sub-menus for 
speedier data transfer. For example, you should synchronize Clients before Projects and 
Invoices before Payments.  

3. PTLinkID Rule: BillQuick automatically creates an internal PTLinkID and adds it to the 
database. Used for internal processing, the special ID ensures accurate and complete 
transfer of data. 

4. Bill Rate, Cost Rate Rule: When transferring employee data from Peachtree, BillQuick 
inserts 0$ Bill Rate and Pay Rate. This is because Peachtree supports only hourly billing 
with optional Bill Rate and no Cost Rate. 

5. Client Contacts Rule: Client contacts in BillQuick transfer to Peachtree automatically 
when you synchronize clients. 

6. Time Record Rules:  

¶ After transferring a time record from BillQuick to Peachtree, it can only be 
transferred again as a new entry or record. 

¶ Negative time entries cannot be transferred to Peachtree from BillQuick. 

7. Placeholder Data Rule: Because Peachtree does not require the same data fields as 
BillQuick and it may not track the same data as BillQuick (does not have the same fields), 
BillQuick inserts ôFromPeachtreeõ (for example) as a placeholder value when it 
encounters these situations. As part of the data checking procedure, you would change 
FromPeachtree to whatever value you desire for the field. For example, if the First and 
Last Name fields on Peachtreeõs Vendor screen are blank, BillQuick inserts 
FromPeachtree into its First and Last Name fields during synchronization. 

8. Peachtree Invoice Rules: When transferring invoices from Peachtree to BillQuick, 
several scenarios can arise.  

¶ Client Invoice but No Job Record: When BillQuick encounters an invoice from 
Peachtree that is associated with a client rather than a job/project, it 
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automatically creates a project record and uses the Client ID to create the 
Project ID. This is done because BillQuick requires projects, and invoices are 
associated with projects (scopes or types of work) done for clients. 

¶ Invoice for One Job, different Client: When BillQuick encounters an invoice from 
Peachtree that contains items for a single project with a client other than the 
invoice client; it associates the invoice with the specific client of the project. 

¶ Invoices for Multiple Jobs, Same Client: When BillQuick encounters an invoice from 
Peachtree with items for different jobs but the same client, it creates a ôjoint 
invoiceõ. In other words, the invoice items for each job are associated with the 
corresponding project in BillQuick. Together, they are reported in BillQuick as a 
Joint Invoice. 

¶ Invoices for Multiple Jobs, Different Clients: When BillQuick encounters an invoice 
from Peachtree with items for different jobs and those jobs involve more than 
one client, BillQuick will not transfer the invoice. You must revise the invoice in 
Peachtree so it only reflects items for jobs associated with a single client, and 
then synchronize with BillQuick again. 

9. BillQuick Invoice Rule: When BillQuick sends an invoice with taxes to Peachtree, there 
are two items (Service Amount and Service Tax Amount) appearing as a single line item. 
Hence, different accounts cannot be specified for them.  

10. Payment Rule: Like invoices, when transferring payments to/from BillQuick, several 
scenarios can arise. 

¶ Payment to Client Invoice, No Job: When BillQuick encounters a payment from 
Peachtree for a client invoice rather than a job/project invoice, it automatically 
creates a project record (if it does not exist) and uses the Client ID to create the 
Project ID. This is done because BillQuick requires projects, and invoices are 
associated with projects (scopes or types of work) done for clients. 

¶ From Peachtree Payments, No Invoice in BillQuick: When BillQuick encounters a 
payment from Peachtree for which the associated invoice does not exist in 
BillQuick, it will transfer the payment into BillQuick. The payment is ôon-accountõ 
for the client and can be used to pay invoices and/or reduce the net bill amount 
of future invoices. 

¶ No Invoice: A payment entered in BillQuick/Peachtree transfers to 
Peachtree/BillQuick even if the associated invoice does not exist in the other 
application. 
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Initial Integration Scenarios 
 
 
Preferences controlling how BillQuick and Peachtree work together are managed through the Sync 
Settings screen. It is accessed from the Accounting, Peachtree Accounting menu. During integration setup 
and synchronization procedures, both BillQuick and Peachtree must be running. Peachtree allows only 
on-demand synchronization.  
 
 

Security Permissions 
 
Before you ask BillQuick to synchronize data with Peachtree, you (the user) must have security 
permission in BillQuick to perform the task. The BillQuick Supervisor in your company assigns security 
permissions to users. 
 
Second, you must tell 
Peachtree to allow direct 
communication with 
BillQuick. To do this, 
again you must have the 
security permission. 
Once you do, you would 
set the security level for 
BillQuick (called a 
Peachtree Partner) on 
Peachtreeõs Maintain 
Global Options screen.  
 
With Medium security, 
for example, each time 
you synchronize data, 
Peachtree prompts you 
to allow BillQuick to 
access your Peachtree 
database (one currently 
open in Peachtree). 
Other options provide 
more or less open security access. 
 
 

Scenario 1: Existing BillQuick-New Peachtree User 
 
BillQuick users who are new to Peachtree Accounting start by transferring information from BillQuick to 
a new Peachtree database. After creating the Peachtree file and setting synchronization preferences, you 
can initiate synchronization and check the transferred data.  
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Please follow the steps below to integrate BillQuick and Peachtree. 
 

1.  Peachtree Database 
 
Before integrating with BillQuick, a new Peachtree user must first create a Peachtree database and assign 
the Peachtree Partner security level (see Security Permissions above or Peachtree Help for more details). 
 

1. When Peachtree 
opens, choose 
ôCreate a New 
Companyõ. The 
New Company 
wizard launches. 
 

2. Enter company 
name, address 
and other details. 

 
3. Select your 

business type 
and if you wish, 
let Peachtree 
suggest a Chart 
of Accounts for 
your business 
type. If you 
already have a 
chart of 
accounts, enter 
them after 
exiting the 
wizard. 

 
4. Enter your 

preferred 
accounting 
method, period 
and other 
financial data. 

 
5. Enter the 

required 
information and 
exit the wizard. 

 
6. Use the 

Peachtree Setup 
Guide to 
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customize company defaults and create company records.  
 

2.  Backup Database 
 
For the first-time sync, it is important to back up your BillQuick database. Select BackUp Database from 
the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company 
database (for example, the standard installation folder x:\Program Files\BillQuick2009; x = drive letter). If 
you want the database copy to be saved in another location, select Global Settings-Misc from the Settings 
menu and enter a new location.  
 

3.  Sync Settings 
 
For BillQuick to know what data to transfer and other integration preferences, you need to define 
integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. In BillQuick, look at the status line at the bottom. It displays the BillQuick database that is 
open. If it is not the one you want to integrate with the Peachtree database, select File, 
Open Company from the menu, choose the correct company, and then continue to the 
next step. 

 
2. From the BillQuick Accounting menu, select 

Peachtree Accounting, Sync Settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 



BillQuickªPeachtree Integration Guide 
 

©2005-2009 BQE Software, Inc.                                                                                                                                              Page 9 

3. Click on the 
General tab. 
Select the 
Peachtree 
Version that you 
are using. Also, 
select the 
desired 
Peachtree 
Company from 
the drop-down 
list or click 
Browse to locate 
your Peachtree 
file. 

 
4. Click the 

Connect button 
to establish a link to the Peachtree database. If the Peachtree application is not running, it starts 
automatically.  

 
You can see the location of the BillQuick Database that will integrate with the Peachtree. 

 
5. Click the Send 

Settings tab. In 
order, select 
each Module and 
assign desired 
settings to it.  

 
6. You need to 

decide whether 
to send each 
type of BillQuick 
data to 
Peachtree. If you 
wish to restrict 
what data 
records transfer 
to Peachtree, 
choose one or 
more filters. See BillQuick Help for more information. 

 
The Get Settings tab is not used because we are sending data from 
BillQuick to populate a new Peachtree database. 
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7. Click on the 
Accounts tab.  

 
In Peachtree, 
each item is 
associated with a 
General Ledger 
(GL) account. A 
General Ledger 
contains financial 
transactions and 
balances in 
various accounts 
for the specified 
fiscal year or 
time period. It 
represents a 
complete 
collection of accounts (chart of accounts) of a company, transactions associated with these 
accounts, and account balances for a specified period of time.    
 
To ensure billed activities, expenses, invoices and payments update the correct GL account in 
Peachtree, you must specify their default accounts here. Select the desired Peachtree Account ID 
or Account Type Description from the dropdown list. 

 
The GL account that you select depends on whether your company follows a Cash Basis 
or Accrual Basis of accounting. For cash basis, the Income Account is where payments 
from BillQuick are posted. The Sales Account receives invoiced activities or services; and 
the Inventory Account receives invoiced expenses. BillQuick posts costs (time, expenses) 
associated with an invoice to the Cost of Sales Account. For accrual basis, the same 
accounts are used except that the Income Account is not needed. 

 

4.  Send Data 
 
Now you are ready to synchronize data with 
Peachtree. 
 

1. From the Accounting menu in 
BillQuick, select Peachtree 
Accounting, Send to Peachtree.  

 
2. In turn, select each menu item, 

starting with Activities. After the 
progress bar indicates that the 
transfer is complete, open the 
corresponding screens in BillQuick 
and Peachtree and verify the data is 
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complete. See Quick-Check for more information on that. 
 

Repeat this step for the next menu item. Below are the BillQuick menu items and the 
corresponding Peachtree screen. 

 
BillQuick  

Send Menu Item 
Peachtree  

Screen 
Activities* Inventory Item 

(Activity) 
Expense Items* Inventory Item 

(Charge) 
Employees* Employee 

Vendors* Vendor 
Clients* Customer 

Projects* Jobs 
Time Entries Time Ticket 

Invoices Invoice 
Payments Receipts 

Chart of Accounts Chart of Accounts 
* The screen name may be different based on your profession or industry, or if you customized them using 

BillQuickõs Custom Label feature. 

 

5.  Fine-Tune Synchronization Settings 
 
After you check the data transferred to Peachtree, you may wish to change your integration settings to 
ones better suited for day-to-day synchronization. Please see Day-to-Day Integration Settings for more 
information. 
 
 

Scenario 2: New BillQuick-Existing Peachtree User 
 
Peachtree users who are new to BillQuick start by transferring information from Peachtree to a new 
BillQuick database. After creating the BillQuick Company and setting synchronization preferences, you 
can initiate synchronization and check the transferred data.  
 
Please follow the steps below to integrate BillQuick and Peachtree. 
 

1.  BillQuick Company 
 
Before integrating, a new BillQuick user must first create a BillQuick company database. BillQuick 
requires security permission to perform this task (see Security Permissions above or BillQuick Help for more 
details). 
 

1. In BillQuick, select File, New from the menu. Choose the type of database technology 
you wish to use. If unsure, choose Standard.  

 
The database technology available to you depends on the BillQuick 
edition purchased. If you are unsure what edition you licensed, select 

About BillQuick from the Help menu. The edition abbreviation displays right 
after the version number. 
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Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Desktop 
Engine 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Desktop 
Engine 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog, enter a name for the new database. Most 

commonly, the company name is used for easy identification. Click the Open button. 
BillQuick creates the database and opens the BillQuick Startup Interview wizard.  

 
 

The BillQuick Start-Up Interview can be closed and reopened later. To 
do so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your firm database. These codes are not needed 
because items will transfer from Peachtree into BillQuick. Click the Next button.  

 
5. Custom Labels allow you to customize key business terms to your profession and firm-

preferred terminology in BillQuick. Customizing terms eases transition from your old 
time & billing solution. Select your preferred terms from the drop-down lists. When 
done, click the Next button. 

 
6. On the Company 

Name panel, 
enter your 
company name. 
Spell it exactly as 
it appears on 
your License & 
Registration or 
the Evaluation 
Key document 
or email.  

 
7. Click the Next 

button to accept 
the defaults on 
the remainder of 
the panels. You 
can update these 
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options later on the Global Settings and User Preferences screen. On the last panel, click 
the Finish button. 

 
8. The BillQuick 

Initial Setup 
Checklist wizard 
displays. This 
wizard enables 
the first time 
user to create 
master 
information; 
setting up basic 
employee, client, 
project, etc, 
confirming the 
actions using the 
checklists. When 
done, click the 
Close button. 

 
9. The Company 

screen displays. 
Either complete the fields now and click the Save button when done; or click the Close 
button and perform this task later.  

 
10. From the File menu, select Login. For User 
ID, type ôsupervisorõ (without quotes), then 
for password, type ôsupervisorõ (without 
quotes). This gives you full security 
permissions in BillQuick to perform 
integration tasks.  

 
 

2.  Backup Database 
 
For the first-time sync, it is important to back up your Peachtree database. Select Back Up from the File 
menu. Click on the Back Up button on the dialog. 
 

3.  Sync Settings 
 
For BillQuick to know what data to transfer and your other integration preferences, you need to define 
sync settings. Later, you can fine-tune these settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently 
open BillQuick database. If it is not the one you want to integrate with the Peachtree 
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database, select File, Open Company from the menu, choose the correct company, and 
then continue to the next step. 

 
2. From the BillQuick Accounting menu, select 

Peachtree Accounting, Sync Settings. 

 

 

 

 

 

 

 

 

 

 

 
3. Click on the 

General tab. 
Select the 
Peachtree 
Version you are 
using and the 
desired 
Peachtree 
Company from 
the drop-down 
list. 

 
4. Click the 

Connect button 
to establish a link 
to the Peachtree 
database. If the 
Peachtree 
application is not running, it starts automatically.  

 
At the bottom, it displays the location of the BillQuick Database that will integrate with 
the Peachtree data. 
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5. Click the Get 
Settings tab. In 
order, select 
each Module and 
assign desired 
settings to it. 

 
In most cases, 
you only need to 
decide whether 
to get each type 
of Peachtree 
data. If you wish 
to restrict what 
data records 
transfer from 
Peachtree, 
choose one or 
more filters. See BillQuick Help for more information. 
 

4.  Get Data 
 
Now you are ready to synchronize data from Peachtree to BillQuick.   
 

1. From the Accounting menu in 
BillQuick, select Peachtree 
Accounting, Get from Peachtree.  

 
2. In turn, select each menu item, 

starting with Service Items. After the 
progress bar indicates that the 
transfer is complete, open the 
corresponding screens in BillQuick 
and Peachtree and verify the data is 
complete. See Quick-Check section 
for more information. 

 
 
 
 
 
 
 

Bill Rate and Cost Rate in employee records must be updated before 
synchronizing time records. Special bill rates/ cost rates associated with 

work done by employees on a project must be defined in a Service Fee 
Schedule and assigned to the project before synchronizing time records.  
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Repeat this step for the next menu item. Below are the BillQuick menu items and the 
corresponding BillQuick screen. 
 

BillQuick  
Get Menu Item 

BillQuick 
Screen 

Service Items Activity Codes* 
Charge Items Expense Codes* 

Employees Employees* 
Vendors Vendors* 
Clients Clients* 

Projects Projects* 
Time Entries Time Entry 

(Sheet View) 
Invoices Invoice Review 

Payments Payments 

Chart of Accounts 
Chart of 
Accounts 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuickõs Custom Label feature. 

 

5.  Fine-Tune Synchronization Settings 
 
After you check the data transferred to BillQuick, you may wish to change your integration settings to 
ones better suited to day-to-day synchronization. Please see Day-to-Day Integration Settings for more 
information. 
 
 

Scenario 3: New BillQuick-New Peachtree User 
 
If you are new to both BillQuick and Peachtree Accounting, you need to set up company databases in 
both applications, enter and/or import master information in BillQuick (or Peachtree), then synchronize 
the data with the other application. The instructions below cover these tasks.  
 
To gain the most complete and useful practice management information from the start and reduce set up 
time, we recommend that you add or import all master information and other time & billing data into 
your BillQuick firm database, then synchronize it with Peachtree. 
 

BillQuickõs Import/Export function (Utilities menu) reads data in 
Comma Separated Value (comma delimited) or Tab Delimited files. In 

this utility, you can associate each data field with the corresponding one in 
BillQuick. If your old application exports data to a comma - or tab - delimited 
file format, or to Microsoft Excel (which can save data in these file formats), you 
can reduce setup time.  

 

1. BillQuick Company Database 
 
Before setting up integration, a new BillQuick user must first create a new BillQuick company database. 
BillQuick requires security permission to perform this task (see Security Permissions above or BillQuick 
Help for more details). 
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1. In BillQuick, select File, New from the menu. Choose the type of database technology 
you wish to use. If unsure, choose Standard.  

 
The database technology available to you depends on the BillQuick 
Edition purchased. If you are unsure what edition you licensed, select 

About BillQuick from the Help menu. The edition abbreviation displays right 
after the version number. 

 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Desktop 
Engine 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Desktop 
Engine 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog, enter a name for the new database. Most 

commonly, the company name is used for easy identification. Click the Open button. 
BillQuick creates the database and opens the BillQuick Startup Interview wizard. 

 
The BillQuick Start-Up Interview can be closed and reopened later. To 
do so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. For the Business Type, you would select a type if you want BillQuick to copy default 

industry-specific activity (service) and expense codes into your firm database. If you wish 
to use your own set of codes, leave the field blank and click the Next button.  

 
5. Labels allow you to customize key business terms to your profession and firm-preferred 

terminology in BillQuick. Customizing terms eases transition from your old time & billing 
solution. If you selected a business type on the previous panel, common terms or custom 
labels display for your profession. If you left business type blank, these fields will be blank 
too. To select a BillQuick label, click the drop-down. When done, click the Next button.  
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6. On the Company 
Name panel, 
enter your 
company name. 
Spell it exactly as 
it appears on 
your License & 
Registration or 
the Evaluation 
Key document 
or email.  

 
7. Click the Next 

button to accept 
the defaults on 
the remainder of 
the panels. You 
can update these 
options later on the Global Settings and User Preferences screen. On the last panel, click 
the Finish button. 

 
8. The BillQuick 

Initial Setup 
Checklist wizard 
displays. This 
wizard enables 
the first time 
user to create 
master 
information; 
setting up basic 
employee, client, 
project, etc, 
confirming the 
actions using the 
checklists. When 
done, click the 
Close button.  
 

 
9. The Company screen displays. Either enter data now and click the Save button when 

done, or click the Close button and perform this task later.  
 
10. From the File menu, select Login. For User ID, 
type ôsupervisorõ (without quotes), then for 
password, type ôsupervisorõ (without quotes). 
This gives you full security permissions in 
BillQuick to perform integration tasks.  
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2.  Peachtree Database 
 
A new Peachtree user must first create a Peachtree database and assign the Peachtree Partner security 
level (see Security Permissions above or Peachtree Help for more details). 
 

1. When Peachtree 
opens, choose 
ôCreate a new 
companyõ. The New 
Company Setup 
wizard launches. 

 
2. Enter company 

name, address and 
other details. 

 
3. Select your business 

type and if you wish, 
let Peachtree 
suggest a Chart of 
Accounts for your business type. If you already have a chart of accounts, enter them after 
exiting the wizard. 

 
4. Enter your 

preferred 
accounting 
method, period 
and other 
financial data. 

 
5. Enter the 

relevant 
information and 
exit from the 
wizard. 

 
6. Use the Setup 

Guide to 
customize 
company 
defaults and 
create company 
records.  
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3.  Setup Data 
 
Setting up data may be a manual process, utilize imported data, or a combination of both. The sequence 
for efficient setup is: 
 

BillQuick  
Setup Sequence 

BillQuick 
Screen 

Employees Employees* 
Clients Clients* 

Activity Codes Activity Codes* 
Expense Codes Expense Codes* 

Vendors Vendors* 
Projects Projects* 

Time Entries Time Entry* 
(Sheet View) 

Expense Entries Expense Log 
Invoices Invoice Review 

Payments Payments 
Chart of Accounts Chart of 

Accounts 
* The screen name may be different based on your profession or industry, or if you customized them using 

BillQuickõs Custom Label feature. 

 
1. Master information should be set up or imported first. In BillQuick, this data includes 

(View menu) Employee, Clients, Activity Codes, and Expense Codes. If you have 
subcontractors or consultants for whom you record time or expenses, also set up 
Vendors. Other types of master information can be added later.  

 
When setting up new records, you only need to enter data into a few required fields. All 
required fields have BLUE field labels. Other data can be entered now or later. 
 

2. The term ôprojectõ may be changed in BillQuick to Engagement, Matter, Job, Work 
Order or any other term you prefer. Phases and segments are sub-projects or detailed 
breakdowns of work being done for a client. 

 
Projects represent the scope of work or type of service performed for a client. Each 
project record contains contract, billing arrangement, budget, special billing rate, and 
other elements that control how BillQuick adapts to your firm and processes data. When 
billing, BillQuick automatically organizes information by project (with the option to 
create one invoice per project or one invoice for all of a clientõs projects), making it 
easier and faster to bill clients. Also, practice management information is more detailed 
and readily available by project.  
 
An accountant, for instance, may deliver tax, write-up, payroll and consulting services to 
a client, each billed differently (fixed fee, recurring monthly fee, hourly), and possibly, at 
different bill rates for the same employees doing the work. An attorney may handle 
contract, litigation, real estate, and other matters for a client, and again elements of the 
relationships may vary. Architects and engineers often break down projects into phases, 
assigning a portion of the contract amount and/or budget to the phase of work. 
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Add Project records, and as needed, project phases and segments. 
 

3. Determine what time records (e.g. timesheets, daily diaries, time entries in your old time 
& billing application) and expenses (e.g. expense reports) are unbilled. Manually enter or 
import these records into BillQuick. 

 
Before entering time records, review each employee record in BillQuick to 
make sure the Bill Rate and Cost Rate is correct. Also, if special bill rates 

(and special cost rates) apply to work done by employees on a project, be sure 
to define an appropriate Service Fee Schedule and assign it to related projects 
before entering time records. BillQuick uses these rates to calculate the bill 
amount and cost amount of time records. 

 
To manually enter time records, select Sheet View or Simple Time Card from the Time-
Expense menu. Each time record for an employee requires a date, project to be charged, 
activity code, and hours. A memo or extended note is optional. 

 
BillQuick supports Control Hours. To activate the feature, check the 
option on the Sheet View screen. Control Hours warn you if the hours 

entered during a session are different from the specified hours.  

 
To manually enter expense records into BillQuick, Select Expense Log or Simple 
Expense Log from the Time-Expense menu. Each expense record for an employee 
requires a date, project to be charged, expense code, units, and as needed, cost and 
markup (when a default is not part of the expense code). A memo or extended note is 
optional. 
 

4. When recording old invoices in BillQuick, you have several options: 
 

¶ ôProjectõ detailed invoices ð previous project invoices sent to clients. You can 
enter only outstanding (unpaid) invoices, or invoices going back as long as you 
want practice management information available. See A below. 

¶ ôClientõ detail invoices ð previous invoices sent to a client for all work done that 
is not broken out by project. See B below. 

¶ Balance forward invoices ð summary amount by client for all outstanding 
invoices. See C below. 

 
A.  To enter detailed invoices by project. . . 

¶ Select Manual Invoice from the Billing menu. 

¶ Select the ID of the project to which the invoice applies. 

¶ In the Description field, enter a brief description or explanation for the services 
billed in your old system and the total for the services from the old invoice. On 
the next line, do the same for expenses and check the Exp box.  

¶ Verify that Amount Due at the bottom of the screen matches the old invoice.  

¶ Click the Process button. 

¶ Repeat for each detailed project invoice. 
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B.  To enter detailed invoices by client. . . 

¶ Select Create/Review Projects from the Project menu. 

¶ Click the New button. 

¶ Enter a unique Project ID that identifies the project record as existing only for 
detailed client invoices. Fill in the required fields and click the Save button. 

¶ Click the Clone button, select the ID of the project you just defined from the 
drop-down list, check the Clone for Selected Clients box, and select the clients 
for whom you want to add detailed client invoices. Click the OK button. Close 
the Project screen. 

¶ Select Manual Invoice from the Billing menu. 

¶ Select the ID of the first ôclient invoicesõ project.  

¶ In the Description field, enter a brief description or explanation for the services 
and the total amount for all services from the old invoice. On the next line, do 
the same for expenses and check the Exp box.  

¶ Verify that the Amount Due at the bottom of the screen matches the old invoice.  

¶ Click the Process button. 

¶ Repeat for each detailed client invoice. 
 

C.  To enter balance forward invoices by client. . . 

¶ Select Create/Review Projects from the Project menu. 

¶ Click the New button. 

¶ Enter a unique Project ID that identifies the project as existing only for balance 
forward amounts. Fill in the other required fields and click the Save button. 

¶ Click the Clone button, select the ID of the project you just defined from the 
drop-down list, check the ôClone for Selected Clientsõ box, and select the clients 
for whom you want to add balance forward amounts. Click the OK button. 
Close the Project screen. 

¶ Select Manual Invoice from the Billing menu. 

¶ Select the ID of the first ôbalance forwardõ project.  

¶ In the Description field, enter a brief description such as ôBalance Forward for 
Client ABCõ and the total services amount for all outstanding invoices. On the 
next line, do the same for expenses and check the Exp box.  

¶ Verify that Amount Due at the bottom of the screen matches the summary 
balance.  

¶ Click the Process button.  

¶ Repeat the steps above for each balance forward invoice.  
 
5. If you entered any paid invoices, you need to record the associated payment (cash 
receipt) to bring it to ôpaidõ status in BillQuick. Select Payments from the Billing menu and 
record cash receipts, credit memos, and other items for each invoice. Retainer amounts 
and amounts on account can also be recorded on the Payment screen, either to the 
client or to a specific project. 
 
If you entered only outstanding invoices or balance forward amounts, you can move to 
the next step. 
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4.  Sync Settings 
 
Now that you have data set up in BillQuick, you need to transfer it to Peachtree Accounting so that both 
applications begin processing from the same point. For BillQuick to know what data to transfer and your 
other integration preferences, you need to define integration settings. Later, you can fine-tune the 
settings for day-to-day integration (see 5. Fine-Tune Synchronization Settings below).  
 

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently 
open BillQuick database. If it is not the one you want to integrate with the Peachtree 
database, select File, Open Company from the menu, choose the correct company, then 
continue to the next step. 

 
2. From the BillQuick Accounting menu, select 

Peachtree Accounting, Sync Settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Click the 

General tab. 
Select the 
Peachtree 
Version that you 
are using and the 
desired 
Peachtree 
Company from 
the drop-down 
list. 

 
4. Click the 

Connect button 
to establish a link 
to the Peachtree 
database. If the 
Peachtree 
application is not running, it starts automatically.  
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At the bottom, it displays the location of the BillQuick Database that will integrate with 
Peachtree. 

 
5. Click the Send 

Settings tab. In 
order, select 
each module and 
assign desired 
settings to it.  

 
You only need to 
decide whether 
to send each 
type of BillQuick 
data to 
Peachtree. If you 
wish to restrict 
what data 
records transfer 
to Peachtree, 
choose one or 
more filters. See BillQuick Help for more information. 

 
The Get Settings tab is not used because we are sending data from 
BillQuick to populate a new Peachtree database. 

 
6. Click on the 

Accounts tab.  
 

In Peachtree, 
each ôitemõ is 
associated with a 
General Ledger 
(G/L) account. A 
General Ledger 
contains financial 
transactions and 
balances in 
various accounts 
for the specified 
fiscal year or 
time period. It 
represents a 
complete 
collection of accounts (chart of accounts) of a company, transactions associated with these 
accounts, and account balances for a specified period of time.    
 
To ensure billed activities, expenses, invoices and payments update the correct G/L account in 
Peachtree, you must specify them here. Select the Peachtree Account ID or Account Type 
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Description from the dropdown list. Which G/L account you select depends on whether the 
company follows a Cash Basis of accounting or Accrual Basis of accounting.  
 
For cash basis, the Income Account is where payments from BillQuick are posted. The 
Sales Account receives invoiced activities or services, and the Inventory Account receives 
invoiced expenses. BillQuick posts costs (time, expenses) associated with an invoice to 
the Cost of Sales Account. For accrual basis, the same accounts are used except the 
income account is not needed. 

 

5.  Send Data 
 
Now you are ready to transfer data from BillQuick to Peachtree Accounting. 
 

1. From the Accounting menu in 
BillQuick, select Peachtree 
Accounting, Send to Peachtree.  
 

2. From the menu, select each menu 
item in turn, starting with Activity. 
After the progress bar indicates that 
the transfer of data from BillQuick to 
Peachtree is complete, open the 
corresponding screen in Peachtree 
and verify that the data is complete.  

 
Repeat this step for the next menu 
item. Below are the BillQuick Send 
menu items and the corresponding 
Peachtree screen. 

 
 

BillQuick  
Send Menu Item 

Peachtree  
Screen 

Activity Inventory Item 
(Activity) 

Expense Items Inventory Item 
(Charge) 

Employees Employee 
Vendor Vendor 
Clients Customer 

Projects Jobs 
Time Entry Time Ticket 

Invoices Invoice 
Payments Receipts 

Chart of Accounts Chart of Accounts 
* The screen name may be different based on your profession or industry, or if you customized them using 

BillQuickõs Custom Label feature. 
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6. Fine-Tune Synchronization Settings 
 
After you check the data transferred to Peachtree, you may wish to change your integration settings to 
ones better suited to day-to-day synchronization. Please see Day-to-Day Integration Settings for more 
information. 
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Quick Check 

 
 
A standard procedure after initial synchronization of data between BillQuick and Peachtree Accounting is 
to check data. This ensures transferred data is accurate and complete. 
 

BillQuick contains multiple processes to ensure accurate and complete 
transfer of data. However, you may find that a setting in Peachtree may 

have restricted transfer of data. Or you may have inadvertently checked a filter 
on the Sync Settings screen. Checking data before you begin normal processing 
ensures no surprises later.  

 
After synchronizing, go to the section below for the type of data and follow the suggested steps.  
 

1.  Check Activity and Expense Codes   
 
Detailed Checking 
 

1. In Peachtree, select Inventory Items from the Maintain 
menu. 

2. In BillQuick, select Activity Codes from the View menu. 

3. Switch between the applications, selecting the same 
activity/item in both and checking that the data is the 
same.  

4. Repeat this for Expense Codes. In BillQuick, select 
Expense Codes from the View menu. Compare the 
records to Inventory Items in Peachtree.  

 
 
 
 
Summary Checking 
 

1. In Peachtree, select Reports, Report Groups. From the Select a Report dialog, select 
Inventory in the left column. Double-click Item List in the right column. The report 
displays on the screen (if desired, you can print the report). 

2. In BillQuick, select Activity Codes from the View menu. Click the Print button. From the 
in-context report list, select Activity Code Master File Detailed List and click the Preview 
button. The report displays on your screen (if desired, you can print the report). 

3. Compare the two lists to ensure all the activities are transferred. 

4. Repeat steps 2 and 3 for Expense Codes. 
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2.  Check Employees  
 
Repeat the above process for employee data. Use the Detailed Checking or Summary Checking method. 
 
For Summary Checking, in Peachtree select Reports, Report Groups, Payroll, then double-click 
Employee List. In BillQuick, select Employees from the View menu, click the Print button, select 
Employee Master File Detailed List, and click Preview. 
 

Before entering time records, or transferring time records from Peachtree, 
review each employee record in BillQuick to make sure the Bill Rate and 

Cost Rate are correct. Also, if special bill rates (and special cost rates) apply to 
work done by employees on a project, be sure to define an appropriate Service 
Fee Schedule and assign it to related projects before entering or transferring 
time records. BillQuick uses these rates to calculate the bill amount and cost 
amount of time records. 

 

3.  Check Vendors 
 
Repeat the above process for vendor data. Use the Detailed Checking or Summary Checking method. 
 
For Summary Checking, in Peachtree select Reports, Report Groups, Accounts Payable, then double-
click Vendor List. In BillQuick, select Vendor from the View menu, click the Print button, select Vendor 
List, and click Preview. 
 
On the BillQuick Vendor screen, determine which of the vendors transferred from Peachtree (if any) 
should be deleted. Select the vendor from the grid, verify you selected the correct vendor, and click the 
Delete button. 
 

If you enter time records for vendors (subcontractor, consultants) in 
BillQuick, be sure to change the Bill and Cost Rates. When transferred 

from Peachtree, BillQuick inserts $0 as placeholder values in vendor records.  

 

4.  Check Clients/Customers 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For Summary Checking, in Peachtree select Reports, Report Groups, Accounts Receivables, then double-
click Customer Master File List. In BillQuick, select View, Clients, click the Print button on the Clients 
screen, select Client Master File Detailed List, and click Preview. 
 

5.  Check Projects/Jobs 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For Summary Checking, in Peachtree select Reports, Report Groups, Job Reports, then double-click Job 
Master File List. In BillQuick, select Projects, Create/Review Projects, click the Print button on the 
Projects screen, select Project Master File Detailed List, and click Preview. 
 



BillQuickªPeachtree Integration Guide 
 

©2005-2009 BQE Software, Inc.                                                                                                                                              Page 29 

Special Note 
 
BillQuick is project-centric. Each project is associated with a client. Time and 
expenses are charged to a project, and bills are generated by project (though 
multiple bills can appear on a joint invoice).  
 
In Peachtree you may have billed customers rather than jobs (projects). If so, no 
projects appear in BillQuick because there are no jobs to transfer. Similarly, if 
you billed some jobs and some customers, only the existing jobs transfer to 
BillQuick.  
 
However, BillQuick automatically creates projects on-the-fly when you transfer 
customer invoices from Peachtree. The Project ID is based on the Client ID. 
Also, because Project Manager is a required field in BillQuick, and there is no 
corresponding field in Peachtree, BillQuick creates a new employee record with 
placeholder values, ôFrom Peachtreeõ. This maintains data integrity in BillQuick. 
You can decide who is responsible for each project/job later. 
 
Bottom Line: You may need to repeat this quick-check step after synchronizing 
Peachtree invoices to BillQuick. 

 

6.  Check Expense Entries 
 
Repeat the above process using the Summary Checking method.  
 
In Peachtree select Reports, Report Groups, Time/Expense Reports, then double-click Expense Ticket 
Register. In BillQuick, select Time-Expense, Expense Log. To view expense entries by employee, select 
View By: Employee, choose the employee, select Period = All, and click the Refresh button. Click the 
Print button, select Employee Expense Report, and click Preview. 
 

7.  Check Time Entries 
 
Repeat the above process using the Summary Checking method.  
 
In Peachtree select Reports, Report Groups, Time/Expense Reports, then double-click Payroll Time 
Sheet. In BillQuick, select Time-Expense, Sheet View. To view time entries by employee, select View By: 
Employee, choose the employee, select Period = All, and click the Refresh button. Click the Print 
button, select Time Verification Report, and click Preview. 
 

8.  Check Invoice Records 
 
Repeat the above process using the Summary Checking method.  
 
In Peachtree select Reports, Report Groups, Accounts Receivable, then double-click Invoice Register. In 
BillQuick, select Billing, Invoice Review. To view invoices by invoice number, click the Refresh button (do 
not choose any filters), then click the Inv# column heading once to put records in ascending order.  
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9.  Check Payment Records 
 
Repeat the above process using the Summary Checking method.  
 
In Peachtree select Reports, Report Groups, Accounts Receivable, then double-click Cash Receipts 
Journal. In BillQuick, select Reports, Payments, Cash Receipts Journal. On the filter panel, click the 
Preview button.  
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Day-to-Day  
Integration Settings 

 
 
After completing initial synchronization, review current settings to determine if they should be fine-tuned 
for day-to-day process. Below are situations to consider for each type of data. 
 

Master Information 
 
Consider where you want to save each type of master information ð activity codes, expense codes, 
employees, clients, projects. When you add, edit or delete records, do you want this task done in 
BillQuick, in Peachtree, or either? 
 
Commonly, companies maintain employees, clients, activity codes, expense codes and project records in 
BillQuick only. This is the core information essential to effective practice management and maintaining it 
in BillQuick is appropriate. To enforce this policy, users ôturn offõ getting this type of data from Peachtree 
on the Sync Setting-Get Setting screen by selecting the desired module and checking the ôDo Not Getõ 
option. 
 
Where you maintain client (customer) records can depend on your specific situation.  
 

Situation Sync Setting Action 

Require extensive customer 
information (e.g. sales and 
payment defaults) 

On the Send Settings tab, 
select Client and check the 
Do Not Send box. 

Maintain customer records in 
Peachtree. Get updated 
records from Peachtree as 
needed. 

Require typical customer 
information  

On the Get Settings tab, select 
Client and check the Do Not 
Get box 

Maintain client records in 
BillQuick. Send updated 
records to Peachtree as 
needed. 

Desire convenience of update 
data common to BillQuick and 
Peachtree, or want to enter 
data in either system 

On the Send Settings and Get 
Settings tabs, select Client and 
make sure both Do Not 
boxes are unchecked. 

Synchronize as needed. 

 
Decisions about employees follow a similar decision process.  
 

Time Records 
 
Whether you transfer time records from Peachtree or not, time entries from employees (and 
vendors/consultants) should be entered into BillQuick. It is designed for maximum data entry efficiency 
and maximum flexibility (4 built-in ways to manage time, plus 5 ways to capture your hours remotely). 
BillQuick also includes numerous time and expense and work-in-progress reports. 
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If you do payroll through Peachtree, you would send time records to Peachtree. Make sure the Do Not 
Send box for Time Entries is unchecked on the Send Settings tab. BillQuick Time Entries become 
Peachtree Time Tickets. If payroll is not done through Peachtree, there is no reason to send time entries 
to it. Check the Do Not Send box for Time Entries on the Send Settings tab.  
 

For payrolls done using other applications, you can export time entries 
using BillQuickõs Import/Export feature (Utilities menu).  

 

Expense Records 
 
BillQuick supports only getting expenses from Peachtree Accounting. To transfer expenses to BillQuick, 
make sure the Do Not Get box for Expenses is unchecked. To disable transfer, check the box. 
 

Invoice Records 
 
Maintaining accounts receivables, doing billing and creating invoices in BillQuick is the best course of 
action because it provides details critical to effective practice management. The most common 
synchronization setting for invoices is the Do Not Send box is unchecked and the Do Not Get box is 
checked.  
 
There can be exception to this situation. For example, if you generate product invoices in Peachtree, and 
you want to record payments for all invoices in one application, then you would not turn off getting 
invoices from Peachtree.  
 

Payment Records 
 
Like client records above, you may decide to record payments for invoices and retainers in either 
BillQuick or Peachtree. Or you may choose the convenience of entering payments in BillQuick. Mark the 
Do Not Send and Do Not Get according to your preference. 
 
 
 

 
Congratulations! Now, you are familiar with the data flow between BillQuick and Peachtree; how to 
ensure that the data transfer is accurate and how to verify which records have integrated. For more 
information, you can check BillQuick 2009 Help. 
 
For more information, visit us at www.bqe.com.If you have any trouble in using our integration utility, 
please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please 
call us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com. 

http://www.bqe.com/
mailto:Support@bqe.com
mailto:Sales@bqe.com

